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ArcSoft End User License Agreement 
 

PLEASE READ THE FOLLOWING TERMS (“Agreement”) CAREFULLY.  USE OF THE SOFTWARE (defined below) PROVIDED BY ARCSOFT IS 
PERMITTED ONLY UNDER AND IN ACCORDANCE WITH THIS AGREEMENT.  IF YOU DO NOT AGREE TO BE BOUND BY THIS 
AGREEMENT, PLEASE DO NOT USE THIS SOFTWARE.  IF YOU OBTAIN THIS SOFTWARE IN FORM OF CD WITHOUT PRINT COPY OF 
THIS AGREEMENT, AND YOU DO NOT HAVE OPPORTUNITY TO READ THIS AGREEMENT, YOU MAY RECEIVE A FULL REFUND OF THE 
ORIGINAL PURCHASE PRICE IF YOU (i) DO NOT USE THIS SOFTWARE, AND (ii) RETURN IT WITH PROOF OF PAYMENT TO THE PLACE 
WHERE IT WAS PURCHASED WITHIN 30 DAYS OF THE  PURCHASE DATE OR AS REQUIRED BY SUCH PLACE. 

 
1. Grant of License.  This Agreement permits you to use one copy of 
the Software or the Software included in this package or device on any 
single computer (“Software”).  For each software licensee, the program 
can be “in use” on only one computer or hardware device at any given 
time. The Software is “in use” when it is either downloaded, copied, loaded 
into RAM or installed into the hard disk or other permanent memory of a 
computer or other hardware device. 
 
2. License Restrictions.   YOU MAY NOT RENT, LEASE, 
SUBLICENSE, SELL, ASSIGN, LOAN OR OTHERWISE TRANSFER 
THE SOFTWARE OR ANY OF YOUR RIGHTS AND OBLIGATIONS 
UNDER THIS AGREEMENT.  You may not modify, translate, reverse 
assemble, decompile, disassemble or otherwise attempt (i) to defeat, avoid, 
bypass, remove, deactivate or otherwise circumvent any software 
protection mechanisms in the Software, including without limitation any 
such mechanism used to restrict or control the functionality of the 
Software, or (ii) to derive the source code or the underlying ideas, 
algorithms, structure or organization from the Software (except to the 
extent that such activities may not be prohibited under applicable law).   
However, you may transfer all your right to use the Software to another 
person or organization, provided that (a) the followings are also transferred 
with the Software, (i) this Agreement; (ii) other software if contained in the 
original package, and/or hardware that the Software is bundled; (iii) any 
original or updated version of the Software; (b) no copies including back-
up and installed in your computer or other device are at your possession 
after the transfer, and (c) the recipient accepts all the terms of this 
Agreement.  In no event shall you transfer the Software obtained as a trial, 
test version, or otherwise specified as not for resale.  A special license 
permit from ArcSoft is required if the program is going to be installed on a 
network server for the sole purpose of distribution to other computers.   
 
3. Copyright.  The Software or the Software contained in this package 
or device is protected by United States copyright laws, international treaty 
provisions, and all other applicable national laws.  The Software must be 
treated like all other copyrighted materials (e.g. books and musical 
recordings).  This license does not allow the Software to be rented or 
leased, and the written materials accompanying the Software (if any) may 
not be copied. 
 
4. Ownership.  Title, ownership rights, and all intellectual property 
rights in and to the Software and any accompanying documentation, and 
any copy of the foregoing, and any sample contents shall remain the sole 
and exclusive property of ArcSoft and/or its third party licensors.  You 
agree to abide by the copyright law and all other applicable laws.  You 
acknowledge that the Software contains valuable confidential information 
and trade secrets of ArcSoft and/or its third party licensors. 
 
5. Warranty Disclaimer.  THE SOFTWARE IS MADE AVAILABLE 
TO YOU ON “AS IS” BASIS. NO WARRANTIES, EITHER EXPRESS 
OR IMPLIED, ARE MADE WITH RESPECT TO THIS SOFTWARE, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE AND WARRANTIES FOR NON-INFRINGEMENT OF 
INTELLECTUAL PROPERTY, AND ARCSOFT EXPRESSLY 
DISCLAIMS ALL WARRANTIES NOT STATED HEREIN.  YOU 
ASSUME THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE SOFTWARE.  SHOULD THE SOFTWARE 
PROVE DEFECTIVE, YOU, AND NOT ARCSOFT OR AN 
AUTHORIZED RESELLER, ASSUME THE ENTIRE COST OF 
NECESSARY SERVICING, REPAIR, OR CORRECTION.  SOME 
STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO 
YOU.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, 
AND YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY FROM 

STATE TO STATE.  YOUR SOLE REMEDY AND THE ENTIRE 
LIABILITY OF ARCSOFT ARE SET FORTH ABOVE.   
 
6. No Liability for Consequential Damages.  YOU AGREE THAT IN 
NO EVENT SHALL ARCSOFT OR ITS AGENTS BE LIABLE FOR ANY 
LOSS OF ANTICIPATED PROFITS, LOSS OF DATA, LOSS OF USE, 
BUSINESS INTERRUPTION, COST OF COVER OR ANY OTHER 
INDIRECT, INCIDENTAL, SPECIAL, PUNITIVE OR CONSEQUENTIAL 
DAMAGES WHATSOEVER ARISING OUT OF THE USE OF OR 
INABILITY TO USE THE SOFTWARE, HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY (WHETHER FOR BREACH OF 
CONTRACT, TORT (INCLUDING NEGLIGENCE) OR OTHERWISE), 
EVEN IF ARCSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. IN NO EVENT WILL ARCSOFT BE LIABLE TO YOU 
FOR DAMAGES IN AN AMOUNT GREATER THAN THE FEES PAID 
FOR THE USE   THE FOREGOING LIMITATIONS APPLY TO THE 
EXTENT PERMITTED BY APPLICABLE LAWS IN YOUR 
JURISDICTION.   
 
7. Export.  You will not export or re-export the product incorporating the 
Software without the appropriate United States or foreign government 
licenses. 
 
8. U.S. Government Restricted Rights.  If you are a unit or agency of the 
United States government, the Software and related documentation are 
deemed to be “commercial computer software” and “commercial computer 
software documentation,” respectively, pursuant to DFAR Section 227.7202 
and FAR Section 12.212(b), as applicable.  Any use, modification, 
reproduction, release, performing, displaying or disclosing of the Software 
and/or the related documentation by the United States government shall be 
governed solely by the terms of this Agreement and shall be prohibited except 
to the extent expressly permitted by the terms of this Agreement.  Any 
technical data provided that is not covered by the above provisions is deemed 
to be “technical data-commercial items” pursuant to DFAR Section 
227.7015(a).  Any use, modification, reproduction, release, performing, 
displaying or disclosing of such technical data shall be governed by the terms 
of DFAR Section 227.7015(b).   
 
9. Termination.  THIS AGREEMENT SHALL BE EFFECTIVE UPON 
INSTALLATION OF THE SOFTWARE AND SHALL TERMINATE 
UPON THE EARLIER OF: (i) YOUR FAILURE TO COMPLY WITH ANY 
TERM OF THIS AGREEMENT; OR (ii) RETURN, DESTRUCTION OR 
DELETION OF ALL COPIES OF THE SOFTWARE IN YOUR 
POSSESSION.  ArcSoft’s rights and your obligations shall survive the 
termination of this Agreement.    
 
10. High Risk Activities.  The Software is not fault-tolerant and is not 
designed or intended for use in hazardous environments requiring fail-safe 
performance, or any other application in which the failure of the Software 
could lead directly to death, personal injury, or severe physical or property 
damage (collectively, “High Risk Activities”).  ARCSOFT EXPRESSLY 
DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS 
FOR HIGH RISK ACTIVITIES.  
 
11. Governing Law and Jurisdiction.  This Agreement will be governed 
by and construed under the laws of the State of California and the United 
States as applied to agreements entered into and to be performed entirely 
within California, without regard to conflicts of laws provisions thereof and 
the parties expressly exclude the application of the United Nations Convention 
on Contracts for the International Sales of Goods.  Suits or enforcement 
actions must be brought within, and each party irrevocably commits to the 
exclusive jurisdiction of the state and federal courts located in Santa Clara 
County.   
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INTRODUCTION 
 
PhotoBase Deluxe covers a wide variety of 
functions that revolve around your videos, 
pictures, and music files. We'll discuss a variety 
of these features and show you how to get the 
most out of your media. Don't forget to utilize 
the built-in Help file! 
 
SYSTEM REQUIREMENTS 
• Windows 98SE/ME/2000/XP 
• Pentium II-based processor or equivalent 
• 150 MB free hard disk space 
• 64 MB RAM (128 MB highly recommended) 
• 16-bit color display at 800 x 600 
 
TECHNICAL SUPPORT 
For technical support, please visit www.arcsoft.com. 
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ARCHIVING/CD BACKUPS 
 
Sure, it's a blast taking pictures and shooting video. And your MP3 collection is probably huge by 
now. But despite hard drives offering more and more capacity, your files still manage to gobble up 
all the space on your computer. Well, now you can archive files to an allocated spot on your hard 
drive, or export them to CD or other removable media. 
 
Click "Create" on the menu, and choose "Archive/Backup." 
 

 
 
The procedure is basically the same for all the choices you see above (CD, Removable Media, Other 
Locations), but we'll walk through creating a CD backup. CDs are great because you can label and 
file them away for fast access later. Not to mention they let you free up space on your hard drive. 
 
After you select where you want to store your files, click the "Next >>" button. The next screen 
lets you choose the files you wish to archive: 
 

 

Use the left side of the screen to 
locate and select your files. You can 
search within your albums or within 
the folders on your system. 
 
• Highlight the files you wish to 

archive (hold down CTRL while 
clicking to select multiple files), 
and then click the ">>" button. 

• If you wish to add all files within 
the current location, simply click 
the "All>" button. 

• If you accidentally add a file that 
you didn't intend on adding, 
highlight the file (on the right 
side of the screen this time) and 
click the trashcan icon. 

 
When you're ready, click "Archive." 
 
When burning a CD, a standard Burn/Write dialog will appear, letting you select the drive, drive 
speed, etc. 
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ARCSOFT RENAMER™ 
 
ArcSoft Renamer™ is a super-convenient tool that lets you quickly rotate photos and rename files 
of all types. Click "Renamer" on the toolbar to launch it. 

 

You can browse all of the files in the 
current location by clicking the arrow 
buttons. 
 
Photos can be rotated in 90-degree 
increments. All you need to do is click 
the respective "Rotate" button. 
 
Renaming files is a cinch. Click inside 
the "Name" field and type over the 
existing name. 
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EMAILING 
 
It's a snap to send photos, videos, or any other type of file (or files) via email. Remember though 
that not everyone has a fast Internet connection, so be sure you don't overload your buddy's Inbox 
with a bunch of really huge files. One way to prevent this is to compress your images. Don't worry, 
it isn't complicated. As a matter fact, the program takes care of it for you automatically! 
 
First off, choose the files that you want to send (hold down the CTRL key while clicking files to 
select them). Then, click "Email" on the toolbar. (You can also choose "Email" from the Create 
menu). 
 

 
 
A window will appear. It offers you detailed information about the attachments. You'll see the 
number of files you've included, the total size of the files, and the approximate time it will take to 
send/receive using various low-speed connections. 
 
More importantly is the information and options to the left. If you're including photos, you can have 
the program automatically resize them to allow for faster sending/receiving. Your photos can be 
compressed and converted to JPEG files (if they aren't already), and resized according to your 
instructions (you can choose 50%, 75%, or 100%). This is entirely optional. If you want to include 
your original photos, simply choose "Attach Original." 
 
When you click "Attach," a blank mail message will appear. Simply fill out the email like normal and 
send it off. 
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EXPLORE OPTIONS 
 
FILE NAVIGATION 
When using the Explorer panel, you can navigate to any location on your computer to view any 
group of files. Click "Explore Options" and you'll see a list of various starting points from where you 
can begin your file browsing. 
 

 
 
Files in the selected folder will appear in the preview area. Thumbnails will represent the actual 
files. Here are a few points to remember: 
 

• Treat files like you would if you were browsing in Windows Explorer. If you delete a file, it 
will be placed in the Recycle Bin. Unlike when you work with albums (which consist of 
shortcuts), here you're dealing with the actual files. 

• If not all of your files are appearing, you may have a file filter active. Go to the View menu 
and choose "File Filter." From there, you can choose which files are visible: All Files, All 
Media Files, Image Files, Audio Files, and Video Files. Choose "Show All Files" to see each 
and every file located in the specific directory. "All Media Files" includes all photos, videos, 
and audio files. 

 
"MY MEDIA FOLDERS" 
Notice that the bottom of the Explore Options list shows a section for "My Media Folders" (see the 
"My Media Folders" section for more information). 
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HOTLINK BAR 
 
The Hotlink Bar contains shortcuts to other programs. These shortcuts are similar to the program 
shortcuts on your desktop. Simply click 'em, and the respective program will open. Alternately, you 
can drag a file onto a hotlink to open the file within the program. 
 
You have full control over the items in your Hotlink Bar. You can add/remove as you please: 
 

 
 
After clicking the Hotlink button, you can: 
 
ADD A HOTLINK 
Click "Add..." and browse your system for the program file you wish to add (*.EXE). Typically, 
these are in the specific program folders within the "Program Files" directory. 
 
REMOVE A HOTLINK 
Single-click the hotlink you want to remove, and then click "Remove." 
 
When you're finished editing your hotlinks, click "Apply." You should see the Hotlink Bar update 
with any program icons that you've added or removed. 
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MEDIA ALBUMS 
 
Albums are a key feature to the program. It's fairly important that you understand what they are 
and how they work. In a sentence, they consist of thumbnail shortcuts to files stored on your 
system. 
 
Basically, albums let you create highly organized sets of pictures, videos, music files, etc. Since 
albums only contain shortcuts, you can effectively consolidate hundreds of files stored all over your 
computer into one location. While each file may be stored in a completely different location than all 
the others, an album brings them all together. 
 

 
 
You can create multiple albums and have them reference different files. For example, you can 
create an album for family pictures, another for vacation videos, another for your music 
collection... you get the idea. 
 
CREATING AN ALBUM 

 - To create a new album, simply click the "New" button along the top of the Media Albums 
panel. 

 
ADDING CONTENT TO AN ALBUM 
To add content to an album (remember, you're basically creating shortcuts to files on your 
system), click "Add" on the toolbar. You can then browse your system for the files you wish to add. 
Also, you can drag-and-drop content from any folder or album into any other album: 
 

 

Here's what the additional buttons 
above your media albums do: 
 

 - Click this button to see various 
album information. A blank text 
field offers you space to type in an 
album description. 

 

 - Click this button to sort your 
albums in a variety of ways. 

 

 - Click this button to delete an 
album. You can either remove the 
album only, or remove the album 
and delete all the associated files. 
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"MY MEDIA FOLDERS" 
 
You'll notice that the Explorer panel offers a few more choices aside from basic file browsing on 
your system. When viewing "My Media Folders," you'll see that the program performs a scan of 
your system. What it's doing is effectively locating all the media files on your computer, and 
displaying the folders that contain them in chronological or alphabetical order. 
 

 

 
So, if you're tired of looking 
through all the directories on 
your system for places that 
may have pictures, videos, 
or music files, you can have 
the program find them for 
you automatically. Of course, 
if you have a rough idea 
where they may be, you 
don't need to have the 
program scan your entire 
system.

 
Go to the Tools menu and choose "Options." Then, choose "Media Folder Options." 

 

Here you can choose which folders you want scanned. Note that 
by checking a folder, all subfolders will be automatically 
checked as well. 
 
See the "Explore Options" section for more information about 
the Explorer panel. 
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PHOTO EDITING 
 
A full-featured image editor is included to help you make your pictures look perfect for printing, 
sharing, and including in projects such as slide shows and web albums. Highlight a photo, and then 
click "Editor" on the toolbar: 
 

 
 
You can do all sorts of cool stuff. We'll go over each of the major tools, as well as some of the not-
so-major stuff. The view tools described here match those described in the "Viewing Photos" 
section. 
 
CHANGING PHOTOS 
Use the navigation buttons to toggle through the various images in the current location or album. 

 
 - Jumps to the first image in the current location/album. 
 - Displays the previous image. 
 - Displays the next image. 
 - Jumps to the last image. 

 
ZOOMING IN & OUT; PANNING 
If you've taken pictures with a megapixel camera, your photo may be too large for proper 
viewing/editing. Use the "Zoom In" and "Zoom Out" buttons to reach a more desirable view of your 
picture. Use the Pan tool to scroll to areas of the photo that can't be displayed within the preview 
window. 
 

 - Zooms in on the photo. 

 - Zooms out. 

 - Choose various zoom ratios from this pull-down. 

 - Click and drag on the photo to see areas that go beyond the workspace. 
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CROPPING 
Cropping involves isolating specific areas of an image, or removing excess, unwanted sections. The 
Editor offers three various crop techniques. Click the little down arrow on the "Crop" button to see 
the various choices: 
 

• Free Cropping - Lets you specify the area that you want to keep by manipulating a 
marquee, or "crop box" (see the image below). Click and drag within the crop box to move 
it around the image. Click and drag the corners to resize the crop box. You can also click 
and drag any of the sides to expand/contract the width/height. 

• Constrained to... - This option is best when you want to ensure that your final image is a 
specific ratio or dimension. Choose the dimension you want from the pull-down. "Image 
Aspect Ratio" simply means that the crop box will remain the same proportion as your 
original image. You can resize and reposition it, but the proportions will remain the same as 
the original. 

• Fixed Size - Choose this option if you want the crop box to be a specific size. You can set it 
according to actual pixels, or inches/cm. 

 
Double-click within the crop box (or right-click) to execute the crop. Everything outside of the crop 
box will be cut out. 

 
 

RESIZING 
You can resize photos by entering in the exact pixel size you want. Alternately, you can resize 
based on inches/cm. In this case, the program automatically configures the pixels and DPI of the 
image in order to provide you with an image that will print at a standard print size. 
 

 
 
You'll almost always want to keep the "Keep Image Aspect Ratio" box checked. This keeps the 
width/height of the resized image consistent with the original. Unchecking this box may lead to a 
distorted picture. 
 
Note: Get a good idea of what your actual image size is by setting the zoom to 100%. Your resized 
photos will be calculated based on this size. 
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ROTATING 
This is a real easy one. All you need to do is click either "Rotate" button until your photo is oriented 
correctly. 
 

 
 
AUTOMATIC COLOR CORRECTION 
The Auto Fix tool offers a great way to quickly enhance your photo. A collection of corrected 
samples is available for you to choose. Each sample alters the brightness/contrast of the photo to a 
slight degree. A small preview window shows you your original. Click and drag within this window 
to focus on various areas of the image. You can also zoom in/out. 
 

 

Check the "Preview" box to see the 
sample effect on your actual image. 
You may need to move the Auto Fix 
window in order to see your original. 

 
 
COLOR MANIPULATING 
The Enhance tool contains various options for altering or improving image color. Click the arrow 
next to the "Enhance" button to see the various options: 
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Independent sliders let you set the intensity of each effect. Whether you're trying to brighten an 
image, alter the overall color, or sharpen it up a bit, the controls are the same--just click and drag. 
The effect window works as a viewfinder or lens over your photo. Effects are seen in real-time as 
you adjust the sliders. Click and drag the effect window to various positions to see how your effects 
appear over different parts of the photo. When you click "OK" to confirm your changes, the effect 
will be applied over the entire picture. 
 
DRAWING/PAINTING 
Ah yes, the most basic of all photo editing... drawing. Click the tool and choose the brush size, 
color, and opacity. The Softness slider lets you adjust how much bleed is applied. The higher the 
softness, the more the paint appears as if it has been airbrushed. Click and drag over your image 
to paint. Use the Eraser tool to remove anything that you've drawn. 
 

 
 

ERASING 
The Erase tool works exactly like the Draw tool, except that instead of coloring the photo, it 
removes any drawing that you may have done. The tool won't erase any of the original photo's 
color; it will only remove color added by the Draw and Text tools. 
 

 
 
ADDING TEXT 
Text can be added to any photo. Click the Text tool, and type your text in the text box. 
 

• You can set the font, size, style, and color. 
• Checking "Wrap" will automatically move added text to the next line when it reaches the 

right edge of your photo. 
• Checking "Anti-Alias" smoothes text edges. 
• Check "Shadow" to add a drop-shadow to your text. Click and drag the shadow in the 

preview window to reposition it. Use the sliders to modify the appearance of the shadow. 
• Before applying your text, click and drag it to position it over your photo. Once your text is 

applied, it becomes permanent. Ensure it is positioned correctly! 
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REMOVING RED-EYE 
The red-eye effect is a common problem when taking pictures using a flash. However, with just a 
few clicks, you can get rid of that pesky problem for good. This tool works by lowering the red 
channel over a specified area. To use it: 
 

• Click the Red-eye tool. 
• Set the size to match that of the affected area. 
• Move your mouse over the red area and click. 

 

 

CORRECTING MISTAKES 
Click the "Undo" and/or "Redo" buttons to progressively step forward or backward to look at your 
various edits. 
 

 
 
SAVING YOUR WORK 
 
Your two choices are "Save" and "Save As." "Save" overwrites the old file with all of your edits. 
"Save As" lets you save your work as a new file. You can enter in a new file name, choose a 
different save location, and change the image file type. 
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PREVIEW AREA 
 
The main preview area displays the files that are stored in the selected folder or referenced in the 
selected album. Double-click a photo to open it in the viewer or editor. 
 

 
 
DISPLAYING SPECIFIC FILE TYPES 
What you see is dependent on a few different settings. First, you can choose to view only still 
images, or only audio files, or only video files. Or, you can choose to view all three types! Viewing 
only specific file types is useful if--for example--you're working on touching up photos and don't 
necessary want to see non-picture files. Of course, if you'd like to view all of the files in the current 
directory or album, you can do that, too. 
 
To choose what files are displayed, go to the View menu and choose "File Filter." From there, you 
can choose which file types are displayed in the preview area:  
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THUMBNAILS, DETAILS, AND LIST VIEWS 
You not only have control over what types of files are displayed; you also have control over how 
the files are displayed. If you look in the top-right corner of the preview area, you'll notice three 
options: Thumbnails, Details, and List. 
 

• Thumbnails - This is the default view. Small images are used to represent files. For photos, 
you'll simply see a miniature version. For video files, you'll see the first frame of the video. 
Audio files are represented with an audio icon. Other files will be represented by their 
default file type icons. You can view either large, medium, or small thumbnails. 

• Details - This option also displays a small thumbnail, but additional information is also 
listed, such as image resolution, date, etc. 

• List - By choosing this option, files will be displayed as a simple text list. 
 
THUMBNAIL ICONS 
While in Thumbnail view, you may notice various icons that appear on certain thumbnails. Here's 
what you may see: 
 

 - This icon means that the thumbnail is a shortcut. By clicking it, you can go to the folder 
that contains the actual file. 

 

 -  By clicking this icon, the EXIF File Reader will launch. It lets you browse the other photos 
in the current location, view and save EXIF text, and listen to and save EXIF audio. 

 

 - This icon indicates that audio is attached to the thumbnail. Click the icon to listen to the 
file. 

 

 - Thumbnails with this icon indicate that the file is a video. 
 

 - Uh-oh. This icon means that you've either deleted, renamed, or removed the original file. 
Remember, albums contain shortcuts, not actual files. You need to be extra careful when 
altering files that are referenced in albums. To try to locate the original file, click the red X 
(or go to the View menu and choose "Find Source File"). A window will appear, letting you 
search your system for the file. 
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PRINTING 
 
A comprehensive set of printing options are readily at your disposal. You can print single image, 
multiple images, and catalog-style proof sheets. Click "Print" on the toolbar and choose the option 
you want: Single, Multiple, or Catalog. (You can also choose "Print" from the File menu.) 
 
SINGLE IMAGES 
Printing a single image is fairly straightforward. You have a variety of options that let you print the 
image exactly how you want. All you need to do is adjust the settings and click "Print." 
 

 
 
• Add Title - Check this box to add text to the print. Double-click the text box that appears in 

the preview, and type in your title. You're free to adjust the font, size, color, and style of the 
text. Click and drag the text box wherever you want. 

• Add Frame - Check this box to add a black line border around your print. 
• Alignment - Check the boxes here to center your title and image on the page. 
• Image Size - You can see the exact width and height of the print. Use the slider to adjust the 

size. Take careful note of the DPI as you make changes; if it drops below 200, you may notice a 
significant drop in print quality. 

• Orientation - Choose between "Portrait" and "Landscape." The preview will reflect your choice. 
• Jewel Case Label - Check this box if you're printing for a CD/DVD jewel case. 
• Copies - Set your number of copies in this area. 
 
MULTIPLE IMAGES 
Save paper, time, and money by printing multiple images at one time. You have complete control 
over the size and orientation of the photos. Because you may be printing multiple pages, you can 
preview each page. Use the arrows beneath the preview to navigate from page to page. 
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• Print - Choose to print only the images 
that you have selected in the current 
album/folder, or all images in the current 
area. Check "Single Image/Page" if you 
only want one photo printed on each page. 

• Print Mode - From the pull-down, you can 
choose the size of the images. There are 
several standard photo sizes from which to 
choose. Check the "Auto Crop" box to have 
the program automatically crop your 
photos to fit the selected size. Checking 
"Auto Rotate" orients your photos for 
optimal prints. 

• Orientation - Change the direction of the 
page (choose from "Portrait" and 
"Landscape"). 

• Print Range - Choose to print all possible 
pages ("All") or only those within the range 
that you select. 

 
CATALOGS 
The application offers a convenient way to create informative proof sheets. Use the arrows beneath 
the preview to see each page before you print. Magnification controls are also available so that you 
can zoom in/out to ensure that everything is just how you want it. 
 

 

• Print - Choose to print all or 
selected images within the current 
directory. You can also print a 
selected range (i.e., images 5-15, or 
20-40, etc.). 

• Display - Choose how many 
thumbnails will be printed on each 
page. You can also choose to include 
a header, footer, or both (double-
click the header/footer to modify the 
text). In addition, you can choose to 
include descriptive text beneath each 
thumbnail. Click "Select Fields" to 
choose which text you want 
included. Click "More Options" for 
additional settings, such as the 
ability to make each thumbnail the 
same size, include the page number 
at the bottom of each page, and 
include thumbnails for non-image 
files. 

 
• Orientation - Like when printing in either of the other modes, you can set the orientation of 

the page. 
• Print Range - Choose to print all pages, or a specific range. 
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REMOVABLE MEDIA/PDAs 
 
Click "Get Photo" on the toolbar and choose "Removable Media" to grab images from connected 
devices. It's easy to grab photos from your pen drives, media cards, etc. All you need to do is 
choose the drive that has the photos you want. 
 

 

• From the pull-down, select the drive you 
want. You'll see thumbnails of the photos. 

• Check the photos that you'd like to copy to 
your computer. Check "All" to select them 
all. 

• Click the "Browse" icon to set the save 
location. 

• You can type in a new prefix to rename the 
photos. For example, you can call all of 
your pictures "Vacation." Each photo will 
be called "Vacation," followed by a number 
(1, 2, 3, etc.). 

• You can choose to add the downloaded 
photos to an album; use the pull-down to 
select the album you want. 

• When you're ready, click "OK." When 
complete, you'll see a summary detailing 
the transfer. 

 
PDAs 
ArcSoft offers a fun and powerful application that brings total image management to your PDA. 
Click the PDA icon on the toolbar to learn more! 
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SLIDE SHOWS 
 
You can create fun slide shows that consist of still images and video clips. You can also add your 
own soundtrack. Click "Slide Show" on the toolbar and choose "Produce." 
 

 
 
SELECTING YOUR FILES 
The first thing you need to do is choose the content you want to use in your slide show. You can 
add files from your albums or any folder on your computer, and use photos, videos, and audio files. 
In the "Browse" section of the Produce Slide Show screen, click either the album or Explorer 
button. If you choose to add content from an album, use the drop-down to choose the specific 
album. If you choose to add from a folder on your system, click the Browse button to select the 
folder. You can add from multiple albums and folders; you aren't limited to choosing content from 
one location. The files in the selected location or album will appear beneath. Click the file you want 
to add, and then click the ">>" button to add it to your slide show. To select multiple files, hold 
down the CTRL key while clicking each file. To add all the files, click the "All>" button. 
 
ARRANGING YOUR SLIDES 
Your photos and videos will appear in the order in which they are added. Any audio files that you 
add will appear below. Feel free to click and drag to rearrange the order of your files. 
 
ADJUSTING SLIDE TIMES 
Notice below each slide there is a time. This is the time that the slide will be displayed before 
moving to the next. To adjust the display time for a specific slide, highlight it, and then enter in the 
desired time in the "Slide Duration" section. If you would like your slides to display consistently 
throughout the presentation and match the duration of the accompanying audio, simply check the 
"Fit to Audio" box. The slide display times will be automatically set by the program. 
 
SETTING TRANSITIONS 
Transitions are effects that occur as one slide changes to the next. Choose the effect you want 
from the pull-down. To apply a random set of effects, choose "All Effects (Random)." 
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ADDITIONAL SETTINGS 
Click the "Settings..." button to view and select optional features for your slide show: 

 

In the "Audio" section, check the box if you would 
like any audio files that may be attached to your 
photos/videos to be played during the slide show. 
(This option will be greyed-out if none of the files 
you've added have attached audio.) The "Display" 
section presents various text you can choose to 
include over your slides. If you choose any of 
these options, set the font type, size, style, and 
color in the "Font" area. Some of your slides may 
not fit completely on the screen. In these cases, a 
plain background color will be seen. You can 
choose this color from the "Background" pull-
down. Black or white usually work the best. 

 
SAVING YOUR SLIDE SHOW 
Click "Produce" to save your slide show: 

 

Type in a name for the slide show in the "Project 
Name" field. In the "Destination" area, choose to 
save your project to a CD or to your computer (if 
the latter is chosen, you can specify the save 
location by clicking "Select Directory"). Lastly, 
choose the format: NTSC or PAL. If you're in the 
US, choose NTSC. 
 
To start saving, click "Done." 
 
To view the slide show, go to the directory in 
which it is saved and double-click the EXE file. 
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TOOLBAR OVERVIEW 
 
The toolbar offers a variety of tools, most of which are accessible through one of the menus along 
the top of the screen. Let's take a look at the toolbar and see what kinds of things you can do: 
 

 
 
ADD 
Use this tool to add photos to an album. This icon becomes inactive when using the Explorer panel. 
 
GET PHOTO 
Click this button to import photos into the current folder/album from connected cameras, scanners, 
or removable media. Just follow the instructions for downloading pics from your device 
manufacturer. 
 
SORT 
This tool lets you sort files in the preview area based on name, file type, size, date, title, keyword, 
or description. You can sort in either ascending or descending order. 
 
EDITOR 
Refer to the "Photo Editing" section to learn how to edit/enhance your photos. Enhance blurry and 
dull images, remove red-eye, crop out unwanted areas, and more. 
 
ROTATE 
Use this tool to rotate photos to the left or right in 90-degree increments. 
 
BATCH 
Batch commands are incredible time-savers. They let you perform a process on a group, or "batch" 
of files in a single shot. There are three batch options: 

• Rename - This command lets you rename 
multiple files at one time. You can either 
rename photos you select, or all the photos 
within the current folder/album. All the files 
will have the same name, proceeded by a 
number. The old and new file names are 
listed. 
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• Resize - Here you can resize an entire 
collection of photos at once. If you have a 
megapixel camera, this can be an invaluable 
option. Sometimes you don't need super high-
resolution photos (especially when emailing 
them). Now you can resize them to more 
manageable sizes. If you want, you can even 
save the resized images as new files, so you 
can still keep your original high-res shots. To 
do this, simply choose a directory to which 
you'd like them saved. 

 

 

• Convert - This batch command lets you 
change the file type of a group of photos. Let's 
say you have high-quality uncompressed 
images that you'd like to convert in order to 
make them easier to share via email or the 
Web. This batch process can do the trick. All 
you need to do is specify the file type that you 
want. Additional options may be available 
depending on the file type. 

 

 

RENAMER 
Refer to the "ArcSoft Renamer™" section. This utility lets you quickly preview and rename files. 
You can also rotate photos. 
 
PRINT 
Refer to the "Printing" section to learn about the variety of print options. You can print single or 
multiple photos, or catalog-style proof sheets.  
 
SLIDE SHOW 
Refer to the "Slide Shows" section to learn how to preview and create slide shows. Display slide 
shows on your computer, or save them to CD to share with friends and family. 
 
WEB ALBUM 
Refer to the "Web Albums" section to learn how to make your own HTML albums. Pop them onto a 
CD and take convenient contact sheets with you wherever you go. 
 
EMAIL 
Refer to the "Emailing" section to learn how to share your files via email. Send photos and more. 
 
PDA 
Clicking on this button displays information about PhotoBase Mobile Edition, a great way to help 
you take your photos with you wherever you go. 
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VIEWING PHOTOS 
 
The built-in photo viewer lets you view your pictures in a variety of ways. Zoom in/out, pan, auto-
browse, etc. Most of the view commands here are also available in the photo editor. To open the 
viewer, simply double-click a photo in the preview area. 
 

 
 
CHANGING PHOTOS 
Use the navigation buttons to toggle through the various images in the current location or album. 
 

 - Jumps to the first image in the current location/album. 
 - Displays the previous image. 
 - Displays the next image. 
 - Jumps to the last image. 
 - Scrolls through the photos in the current location/album. Think of it as a slide show, 

without any fancy transitions. Basically, each photo will display for a set amount of time. 
To set the time, right-click the photo on display and choose "Options." 

 
ZOOMING IN & OUT; PANNING 
If you've taken shots with a megapixel camera, your photo may too large for proper 
viewing/editing. Use the "Zoom In" and "Zoom Out" buttons to get a comfortable view of your 
picture. Use the Pan tool to scroll to areas of the photo that can't be displayed within the preview 
window. 
 

 - Zooms in on the photo. 

 - Zooms out. 

 - Choose various zoom ratios from this pull-down. 

 - Click and drag on the photo to see areas that go beyond the workspace. 
 - With this button selected, your photo will automatically be resized to fit fully within the 

view window, regardless of the window size. 
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WEB ALBUMS 
 
Web albums offer you a great way to present your photos through HTML albums. Friends, family, 
business associates or customers--everyone can preview thumbnail images and click to see larger, 
more detailed photos with ease. Save your Web albums to CD and you now have a convenient way 
to distribute and share your pics. 
 
Creating a Web album is a breeze. All you need to do is follow the "wizard" and you can't miss. 
Start by selecting the album or folder that contains the pictures and videos you want to use. Web 
albums are created from the files in one specific location, so make sure that all the content you 
want is in that one album or folder. When you're ready, click "Web Album" on the toolbar. 
 

 

The first thing you need to do is 
choose the files you'd like use. Add 
them in the order in which you'd like 
them to appear in the Web album. On 
the left, click the file you want, and 
then click ">>." To add all of the files, 
click "All>." 

 

 

Next, you can choose the layout in 
which the thumbnails appear on the 
page. Choose the layout that you like 
best. You can also choose between 
three different sizes for the 
thumbnails.  

 



ArcSoft PhotoBase Deluxe 
 

- 26 - 

 

You're almost done! Enter in a title for 
your Web album. This title will appear 
at the top of each page. In addition, 
you can have a variety of information 
appear beneath each thumbnail. 
Simply place a checkmark in the box 
of the text that you would like to 
appear. Lastly, select the background 
color for the album pages. 

 

 

Okay, all that's left is a few things 
that need to be decided before your 
Web album is created. First, choose to 
either save it to your computer or to a 
CD. If the former is chosen, type in a 
name for the project and select the 
save location. If the latter is chosen, 
type in a name for the folder in which 
the project will be saved. When you're 
ready to go, click "Done." 
 
To view the Web album, go to the 
directory in which it is saved and 
double-click the EXE file. 

 


